Release Notes
Notices

© Keysight Technologies Incorporated, 2002-2021

1400 Fountaingrove Pkwy., Santa Rosa, CA 95403-1738, United States All rights reserved.

No part of this documentation may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies, Inc. as governed by United States and international copyright laws.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause.

Use, duplication or disclosure of Software is subject to Keysight Technologies' standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Portions of this software are licensed by third parties including open source terms and conditions.

For detailed information on third party licenses, see Notice.
## Contents

**Advanced Design System 2022 Release Notes** ................................................................. 5

Feature Updates ......................................................................................................................... 5
Design Editing and Layout ............................................................................................................ 5
File and Workspace Management Tools ......................................................................................... 7
Data Display ............................................................................................................................... 7
Circuit Simulation ........................................................................................................................ 8
HSD Design ............................................................................................................................... 9
EM Simulation ............................................................................................................................ 10
Verification .................................................................................................................................. 11
Design Kits .................................................................................................................................. 12
Power Electronics ....................................................................................................................... 12
Virtual Test Bench (VTB) ............................................................................................................ 13
Installation .................................................................................................................................. 14
Licensing ..................................................................................................................................... 14
Documentation ........................................................................................................................... 14

**Known Issues** ....................................................................................................................... 15
Design and Technology Management ............................................................................................ 15
Design Editing and Layout ............................................................................................................ 15
Design Guide ............................................................................................................................... 16
Design Kits .................................................................................................................................. 16
Circuit Simulation ........................................................................................................................ 16
HSD Design ................................................................................................................................ 18
EM Simulation ............................................................................................................................ 19
Signal Processing Simulation ........................................................................................................ 20
Import/Export ............................................................................................................................... 21
Power Electronics ....................................................................................................................... 21
Installation .................................................................................................................................. 21
Licensing ..................................................................................................................................... 22
Third Party Applications .............................................................................................................. 26
Verification .................................................................................................................................. 26
Virtual Test Bench ....................................................................................................................... 26
Examples ...................................................................................................................................... 28
Release Notes

Documentation ................................................................. 29
Advanced Design System 2022 Release Notes

For general information about Advanced Design System (ADS), visit ADS webpage at http://www.keysight.com/find/eesof-ads.

Starting ADS 2022 release, support for the following operating systems has been discontinued:

- Windows 7 Enterprise
- RedHat Linux RHEL 6.x
- SuSe Linux SLES 11

For more information, refer to Supported Platforms.

Contents

- Feature Updates
- Known Issues

Feature Updates

- Design Editing and Layout
- File and Workspace Management Tools
- Data Display
- Circuit Simulation
- HSD Design
- EM Simulation
- Verification
- Design Kits
- Power Electronics
- Virtual Test Bench (VTB)
- Installation
- Licensing
- Documentation

Design Editing and Layout

- **Routing**
  - Enhanced Insert Trace command to add true arcs instead of segmented polyline whenever possible.
  - Enhanced Avoidance Routing to treat arcs in the objects to be avoided as arcs instead of segmented polylines. The performance of avoidance routing, as a result, should improve noticeably especially for designs with many arcs or circles.
  - Enhanced the Keepout object to support the avoidance routing. (ADS 2021 Update 1.0).

- **Ground Plane**
  - Intelligent tracking of Ground Planes needing to be updated. Make necessary Ground Plane update when a design is exported.
  - Enhanced Plane creation/editing to eliminate/reduce the extra notches that could result in prior ADS releases. (ADS 2021 Update 2.0)
  - A new option of Using Rounded Clearance is added to Plane creation/editing. (ADS 2021 Update 2.0).
For more information, see Planes.

- **Interconnect, Connectivity and Pin**
  - Enhanced Create Pin interface to support creation of area pins from existing shapes. (ADS 2021 Update 1.0)
  - A new preference added to disallow connecting a pin to ground in schematic. (ADS 2021 Update 1.0)
  - Enhanced symbol related creation or editing commands to support orientation of instance-based pins. (ADS 2021 Update 1.0)
  - A new preference added to disallow connecting a pin to ground in schematic. (ADS 2021 Update 1.0)
  - OA Path is supported to improve the ADS interoperable flow. Connectivity, netlisting and editing commands involving wide wires are enhanced. (ADS 2021 Update 2.0)
  - Area pins can be assigned to Padstacks and Vias without needing pins pre-existed on those objects. (ADS 2021 Update 2.0)
  - Area pins associated with instances, vias, and pads are correctly displayed in 3D view. (ADS 2021 Update 2.0)
  - Enhanced Physical Connectivity Engine to support instance arrays in layout. (ADS 2021 Update 2.0)
  - Enhanced Physical Connectivity related commands to handle interconnect more robustly and intuitively even when bad connections or bad vias are present. (ADS 2021 Update 2.0)
  - In the Net-based connectivity mode net editing of single or multiple nets can be easily performed in the Properties docking window. (ADS 2021 Update 2.0) For more information, see Connectivity Modes.

- **General Usability Enhancements**
  - Supported editing of attributes of PCB Vias and Pads in the Properties docking window.
  - Supported full-blown polygon editing in the Properties docking window. (ADS 2021 Update 1.0)
  - Added ability to specify any substrate file as the master substrate. (ADS 2021 Update 1.0)
  - Enhanced the Interoperability documentation, including Layout Interoperability, to cover essential information. For more information, see IC Interoperability. (ADS 2021 Update 2.0)

- **AEL Interfaces**
  - New AEL APIs for:
    - Automating GDSII import/export
    - Setting/getting workspace and library preferences
    - Accessing delta gap ports
    - Getting all Padstack attributes
    - Copying padstack. (ADS 2021 Update 2.0)
    - Editing pin shape and snap point. (ADS 2021 Update 2.0)
  - Enhanced Smart Mount proxy related AEL APIs to work with designs having read-only attached technology
  - Enhanced AEL APIs for object transformation (e.g. move, rotate, mirror.) (ADS 2021 Update 2.0).

- **Obsolescence Announcement**
  - The Mask File (.msk) Import/Export translators are obsoleted.
  - The HPGL/2 Export translator is obsoleted.
  - The Boardstation PCB Link Import/Export translators are obsoleted.
  - The Allegro PCB Link Import/Export translators are obsoleted.
  - The IFF Import/Export translators are deprecated. The ADS Board Link (ABL) is the recommended tool. Contact Keysight Tech Support for further assistance.
  - The WYSIWYG connectivity mode will be obsoleted in ADS 2023 release.

**Known Issues**
File and Workspace Management Tools

- **Workspace and Library Management**
  - Enhanced Copy Cell and files to a different workspace
  - Enhanced Copy Cell to allow overwriting/replacing referenced data files. (ADS 2021 Update 1.0)
  - Enhanced Unarchive command to skip over any libraries that have problems, issue warnings for them, and proceed to completion. (ADS 2021 Update 2.0)
  - Enhanced Manage Libraries lib.def editing to retain but notate, in lieu of removing, invalid libraries. (ADS 2021 Update 1.0)
  - Improved Reference performance by caching reference information to disk. (ADS 2021 Update 1.0)
  - cds.lib file is supported, as an alternative to lib.defs, for the workspace library definition. It can be enabled via setting the environment variable USE_CDS_LIB_WORKSPACE to a non-empty value. (ADS 2021 Update 2.0)

- **General Usability Enhancements**
  - A new environment variable, EESOF_TEMP_PATH, can be used to specify the directory for the mini-dump file, the ADS AEL macro recording session file and a few other use cases. (ADS 2021 Update 2.0)
  - The message generated by TCL "puts" calls is displayed in ADS Message List pane where Error/Warning messages are typically shown. (ADS 2021 Update 2.0)
  - Restored ability to set window size and position. (ADS 2021 Update 1.0)

Data Display

- **Data Viewing, Analysis and Manipulation**
  - Added Variable Explorer docking window to view variable values. For more information, see Variable Explorer.
  - Standalone simulations with MeaEqns containing Datalink functions are supported.
  - The environment variable, DATALINK_PYTHONHOME, can be used to redirect Datalink run-time to use a different Python than the one installed under ADS. For more information, see Using pwdatatools Python Package and Python Installation used by Datalink.
  - The combo box for listing dataset is re-sizable. (ADS 2021 Update 2.0)
  - Added a menu option to select all traces in selected plots. (ADS 2021 Update 1.0)
  - Added Drag and Drop support from Expression Manager to DDS page. (ADS 2021 Update 1.0)
  - Added Equation Insert in Expression Manager. (ADS 2021 Update 1.0)
  - Improved error reporting in AEL expressions and ADX translation. (ADS 2021 Update 1.0)
  - Supported indexing a swept variable using another variable as the index (ADS 2021 Update 1.0)

- **Data Display Picture Object**
  - Schematic image can be copied and pasted into a DDS page. In general, any image in the system clipboard can be pasted into a DDS page.
  - Pictures can be inserted to a Data Display page as an image or an expression. For more information, see Pictures. (ADS 2021 Update 2.0)

- **General Usability Enhancements**
Release Notes

- DDS Palette is no longer locked to two columns and instead can be resized. (ADS 2021 Update 2.0)
- Better organized font selection menu that also includes the Most Recent Fonts anew. (ADS 2021 Update 1.0)

For more information, see Data Display.

Known Issues

Circuit Simulation

- **General**
  - Front-end performance and memory improvements.
  - More Spectre and Spice compatibility. For example, Hspice level 68/69 support, hspice unquoted expression, and so on.
  - Support of circuit simulation in PathWave Design Cloud.
  - Simulation manager supports:
    - Non sweep simulation
    - em-cosim
    - Simulation soft link
  - Improvements in Harmonic Balance performance.
  - Implemented BSIM-CMG Version 111.1.
  - Implemented L-UTSOI Version 102.5.
  - GoldenGate-in-ADS will be obsolete starting from ADS 2022.

- **IP Encoder**
  - The ADS 2022 IP encoder now uses a slightly different internal format. Because of this, encoded libraries created by ADS 2022 cannot be read by earlier versions of ADS. Older libraries created by earlier versions of ADS can be read by ADS 2022, but newer libraries created by ADS 2022 cannot be read by older versions of ADS.

- **ElectroThermal**
  - Fixed incorrect power data passed to the Thermal Viewer, and seen in its Power Source Query.
  - Handle more cases of orthotropic thermal conductivity, in finer detail. Note that in the methods explained for orthotropic conductivity, please ensure you set the isotropic conductivity (k) of the original material to the same value as its in-plane (XY) conductivity (kxy). The value of k used in example is 700 W/(mK).
  - Extend use-cases for the static reusable thermal model.
  - Track and report power on parents of given heat sources.

- **User-Compiled Models**
  - On Linux, the gcc/g++ 11.1.0 is now used to build ADS. Models compiled with gcc 8.2.0 should still work with ADS 2022, but is not guaranteed.
  - On Windows, all models must be rebuilt to work with ADS 2022. Visual Studio 2019 is still being used.

- **PDKs**
  - Because the windows compiler has not changed from ADS 2021, PDKs must now use a different, ADS-version-specific location for compiled models.
Earlier to ADS 2022

Location: bin/
$SIMARCH$COMPILER_VER

From ADS 2022

Location: bin/$ADS_MAJOR_VER$SIMARCH$COMPILER_VER
ADS_MAJOR_VER will be set appropriately. For ADS 2022, it will be:

\[
ADS_MAJOR_VER=ADS_2022_
\]

For versions earlier to ADS 2022, ADS_MAJOR_VER is not defined and so the location bin/$ADS_MAJOR_VER$SIMARCH$COMPILER_VER is effectively the same as older versions for backwards compatibility.

For Windows and ADS 2021, this results in bin/win32_64_VS2019
For Linux and ADS 2021, bin/linux_x86_64_GCC820 is used

For Windows, this now results in bin/ADS_2022_win32_64_VS2019. So, ADS 2022 windows models should be placed in this directory. For Linux, the compiler has also changed, and so the ADS 2022 location bin/ADS_2022_linux_x86_64_GCC1110 is used.

The location is reflected in eesof_lib.cfg file by this line (for ADS 2022 and later):

\[
BIN_DIRECTORY=../bin/$ADS_MAJOR_VER$SIMARCH$COMPILER_VER
\]

If an existing PDK is being updated to add models for ADS 2022 (as opposed to being regenerated from scratch), perform the following steps:

i. Recompile the models using ADS 2022.
ii. Copy the rebuilt models to the appropriate directory (either bin/
ADS_2022_linux_x86_64_GCC1110 or bin/ADS_2022_win32_64_VS2019).
iii. Edit all occurrences of eesof_lib.cfg in the PDK and change the line from:

\[
BIN_DIRECTORY=../bin/$SIMARCH$COMPILER_VER
\]

To:

\[
BIN_DIRECTORY=../bin/$ADS_MAJOR_VER$SIMARCH$COMPILER_VER
\]

Known Issues

Back to Feature Updates

HSD Design

• SerDes
New TX_Waveform_AMI component, that supports a measured waveform based AMI model generation.

ADS COM calculation supports COM Version 3.1.

ADS supports single dual pole CTLE.

ADS COM calculation supports COM Version 2.93. (ADS 2021 Update 2)

ADS supports Batch simulation for COM. (ADS 2021 Update 2)

S-Parameter Tool Kit allows saving a file to a different format. (new name for S-Parameter Checker).

S-Parameter Tool Kit supports causality check.

Multi-lane Smart Tx/Rx: Added channel sweep functionality to redrivers. (ADS 2021 Update 2)

**DDR/Memory**

Memory Designer now supports single ended PAM4.

Memory Interface AMI Model Builder supports new single ended PAM4 AMI model generation.

Memory Interface AMI Model Builder supports custom CTLE models.

Memory Probe is enhanced to manually pair single-ended nodes of differential signals, if auto pair is not done.

Memory Designer now supports GDDR6x/GDDR7.

Memory Designer now supports HBM2E/HBM3.

S-Parameter Tool Kit supports causality check.

S-Parameter Tool Kit allows saving a file to a different format. (new name for S-Parameter Checker).

Allows users to choose low frequency extrapolation method between transient solver and device level extrapolation in Tran and DDR Bus simulation controller.

Memory Designer now supports GDDR6. (ADS 2021 Update 2)

New Memory Interface AMI Model Builder for DDR5/LPDDR5. (ADS 2021 Update 2)

Improved S-Parameter Checker, ex: search, NEXT/FEXT/IL/RL plots, and so on. (ADS 2021 Update 2)

Supports IBIS-ISS. (ADS 2021 Update 2)

Enhanced unified parser for IBIS and pre-layout and post-layout models.

Improved usability and robustness of package and DIMM connector support.

**EM-SiPro/PIPro**

**General**

- The clear mesh cache option now removes vmeshData from the simulation directory.
- After simulation, emds solver process stops.
- ODB file (.zip) import now supports space within the filename.

**PIPro**

- ODB Importer - long and complex part properties are now handled as cell names.
- Job Manager now has a hard stop after 45 seconds instead of 15 seconds in the CLMCOMMSTATE_SUBMITJOB state.

**SiPro**

- Fixed the signal matching issue in the DDR4 board.

**Known Issues**

**Back to Feature Updates**

**EM Simulation**

**RFPro Platform Improvements**
• Process variations can be simulated without parameterizing (ADS 2021 Update 1 and Update 2)
  • Over-etching and under-etching
  • Mask registration
  • Conductivity and permittivity spread
  • Thickness spread
  For more information, see the Process Variation section in Creating Full EM Extraction Analysis.
• EMPro 3D components can be added to RFPro simulations (ADS 2021 Update 2)
  • Insert Encrypted or plain EMPro components in ADS to be re-used in RFPro. For more information, see Using EMPro 3D Components.
  • Add Solder balls and bondwires natively inside RFPro. For more information, see Creating 3D Objects.
• EMPro 3D components parameterization
  • Change the parameter values directly in RFPro and simulate its impact. For more information, see Modifying Parameter Values of Imported 3D Components.
• RFPro EM Solver Improvements
  • Momentum Generation 2 (ADS 2021 Update 1)
    • Pre-processing time is now only taking seconds even for a large database.
    • Simulation runtime has been dramatically improved.
    • Quicker and more robust computation of the substrate database.
  • Mesh Domain Optimization (MDO) for Momentum Generation 2 (ADS 2021 Update 1)
    • Augments net extraction by automatically reducing the simulation space of large grounds and power planes to what’s needed.
    • Reduces simulation time of RF critical nets by only simulating what’s necessary.
• FEM Generation 2
  • Support of the waveguide and the delta-gap ports. (ADS 2021 Update 1)
  • New SDS solver improves simulation performance for very large designs.
• RFPro Usability Improvements
  • Use Switch View Lists (ADS 2021 Update 2)
    • Allows using views that have already been pre-processed for EM.
    • Traverses the hierarchy to pick the layout view respecting the user-defined order.
  • Connect implicit bulk nodes (ADS 2021 Update 2)
    • Often layout and schematic views do not have the same number of pins leaving the bulk pin dangling or non-existing.
    • The “Bulk Model” menu allows selecting the closest label to let RFPro directly assign the correct node to the bulk pin.
  For more information, see Bulk Model section in Layout Options.
• PathWave Design Cloud for EM (ADS 2021 Update 1 and Update 2)
  • State-of-the-art job submission that works with all load-sharing tools and also cloud architectures.
  • Jobs can be submitted from Windows or Linux.
  • No need to maintain a live connection between the submitting and the simulation machines.
• RFPro HFSS Option
  • Run Ansys HFSS from RFPro. For more information, see HFSS Link.

Known Issues

Back to Feature Updates

Verification

• Layout Versus Schematic
Release Notes

- Physical Nets LVS supports pad stacks inside component artwork.

- **Design Rule Check**
  - DRC Dialog supports Assura rule files with space characters around the switch name.
  - ADS DRC supports a new rule for local design area density.
    - The Design Area Density rule crops the shapes to a check window and checks the area of the shapes relative to the check window area.
    - The check window moves by a specified offset and the local area density is checked for next cropped area of the design. See Design Rule Check > Design Area Density.

- **PDK Validator**
  - Batch Mode
    - The configuration location can be set to library or workspace for the current job.
  - Test Values
    - Test values can be specified using a range syntax.
    - See PDK Validator > Component Test Values Functions

- **Calibre LVS**
  - Calibre LVS supports a GDSII config file in the PDK rules directory.

- **Netlist Export**
  - Netlist export supports pin names.

Known Issues

Back to Feature Updates

Design Kits

- **Non-Linear Demo Kit**
  - PDK Validator configuration files have been added to automate validation of the PDK (creation of the testcase and checking various features of a PDK). For testing ADS PDKs using PDK validator, see Testing ADS PDKs using PDK Validator.
  - Added a thermal substrate file "tech-multi.tcl" to support multi-tech flow by adding "bound" layer. The layout design must be enclosed by the "bound" layer to demonstrate the chip boundary for multi-tech flow. For more information see, PDK Files.

- **mm-wave Demo Kit**
  - A new ADS demo Kit has been added as a part of ADS2022 release to demonstrate ADS capabilities for 5G applications. For more information, see mmWave Demo Kit.

Known Issues

Back to Feature Updates

Power Electronics

- **PEPro**
  - Broadband SPICE Model Generator (BBSMG). (ADS 2021 Update 1.0)
    - Added a new option to export PSpice compatible model.
    - Added instructions and best practices for creating a PSpice compatible model.
    - Added an indicator for reading large input files.
    - Fixed a bug in the stop simulation functionality, a crash error when enforcing passivity without enabling global poles and a bug in the data display template.
Surface Current Density visualization by layers in PEPPro. (ADS 2021 Update 2.0)
  - Added capability to view the Surface Current Density by layers in the Near Field results.
  - Added a new example to demonstrate Radiated EMI capability in PEPPro. For more information, refer Understanding of Radiation From the PCB Traces.
  - Added a new example to demonstrate the use of PEPPro in simulating a closed loop boost converter. For more information, refer Simulation of Closed Loop Boost Converter.

- **Power Electronics Model Builder Tool**
  - Integration of Keysight's proprietary Artificial Neural Network (ANN) technology for additional optimization to improve the fitting of IV characteristics to the input data.
  - Improved Measured Data validation and error reporting. (ADS 2021 Update 2.0)
  - Improved usability in the way Data Display is used to plot and update measured data and simulation results. (ADS 2021 Update 2.0)
  - Bugfixes related to launch of Data Display and use of Data Display template to plot the results. (ADS 2021 Update 2.0)

- **Netlist Translator**
  - Improvement in the DDT function translation for better convergence.
  - Support to recognize Length, Width parameters found in a MOSFET model card in a PSpice dialect netlist file.

- **Power Electronics Library**
  - ASM HEMT version 101.1 has been added to ADS.

  **NOTE**
  By default, the ASM HEMT model symbol points to 101.1 version. To point to an older version, you need to manually change the version.

  - Fixed a bug in OpAmp5 component.
  - Fixed issues related to ASM HEMT symbol and updated the content. (ADS 2021 Update 2.0)

**Known Issues**

**Back to Feature Updates**

**Virtual Test Bench (VTB)**

For general information about Virtual Test Bench (VTB), visit the VTB webpage at http://www.keysight.com/find/virtual-test-bench.

- Verification Test Bench (VTB) is now called Virtual Test Bench (VTB).
- To install files that are required for the VTB functionality along with the ADS installer, you need to download a separate VTB installer for both Windows and Linux and manually install the VTB.
- If you have already installed ADS and find VTB functionality is missing, then you need to download and manually install the VTB.
- If you want to uninstall, then you need to manually uninstall VTB separately for both Windows and Linux.

For more information, see VTB documentation.

**Known Issues**

**Back to Feature Updates**
Release Notes

Installation

- **Obsolescence Announcement**
  - The LAN Client installation on the Windows platform will be obsoleted in ADS 2022 Update 1 release. Contact Keysight Tech Support for further assistance.

Known Issues

[Back to Feature Updates]

Licensing

- ADS requires: a) the **version 2021.02** of the EEsof EDA licensing software, b) a minimum code-word version **2021.02 or above**, and c) the licensing server software, **lmgrd** and **agileesofd**, to be upgraded to at least the same versions as what are included in EEsof EDA Licensing software **2021.02**. ADS will not start if any of these requirements is not met. Refer to the License Codeword Version Compatibility Table.
- In the EEsof EDA License Tools version 2021.02, licensing vendor daemon (**agileesofd**) is integrated with FlexNet FNP **11.16.5.1** version (Windows) and FlexNet FNP **11.16.5.1** version (Linux) of FlexNet license manager daemon (**lmgrd**). For the Windows platform, ADS installer will automatically set up these two new license server daemons by default for the local node-locked license users; for the Linux platform, you need to follow the Setting Up Licenses on Linux instruction to complete the licensing configuration process. For more details, refer to Licensing (For Administrators).

Known Issues

[Back to Feature Updates]

Documentation

The online help gets a new user interface (UI) that brings new features and enhanced usability. Using the new features, you can do the following among many other things:

- Access most accessed topics in the documentation from the new Home page.
- Browse and use the online help on all device sizes like mobiles, tablets, laptops, and desktops.
- Refine search queries right from the documentation.
- Filter pages in the navigation tree using keywords.
- Apply dark theme.
- Change hyperlinks color.
- Copy code samples with a click.
- Copy links to sections with a click.
- Use keyboard shortcuts to use different features of the user interface.
- Use QR code to open any page on mobile and tablets.

For more details, see How to Use Online Help.

Additionally, the offline help now lets you create PDFs on-the-fly while you are connected to the internet using the PDF button on the top-right corner of pages.
Known Issues

Design and Technology Management

- Cadence Virtuoso IC version 6.1.7 is not supported on RHEL 8 platform.
- Using ADS 2020 with pycell studio 2018 (PyCell Studio Packages: Release O-2018.09) might prompt you an OA version mismatch warning message on the linux terminal. However, there is no impact on the iPDK flow in ADS.
  
  Linux terminal message:
  Requested minor API version '518', which is supported by OpenAccess build '22.50.030' is newer than the minor API version '514' of the shared library of OpenAccess build '22.50.043'.
- The Express Pcell plugin that comes with Virtuoso IC version 6.1.8 does not work with ADS 2020 due to an OpenAccess version mismatch, but the Express Pcell plugin will work with ADS 2020 Update 1.0 and 2.0.

  Workarounds:
  - When running ADS 2020, set the LD_LIBRARY_PATH environment variable path to point to the directory from IC version 6.1.7.
  - Upgrade to ADS 2020 Update 1.0
- The Express Pcell plugin that comes with older versions of Virtuoso IC version 6.1.7 may crash during a simulation with ADS 2020 Update 2.0 due to a third party incompatibility but may work with newer versions above IC version 6.17_722 and up.
- AEL constants are protected and should not be modified in any DDS expressions. An AEL error will be issued in case an attempt to modify an AEL constant occurs.
- **Python Datalink**
  - When using Connection Expert 2019 connected to Lan Instruments, there may be error messages during `dl_visa_query()` and `dl_visa_write()`.
  - Exceed on Demand: Note that in some cases, EoD settings may need to be configured to properly display Spyder. Please contact your EoD support representative for additional guidance.

Design Editing and Layout

- Designs created using Smart Mount for Multi-Technology feature cannot be used to run an electrothermal simulation.
Release Notes

Design Guide

- Unable to unarchive HDMI design guide from the Schematic view (DesignGuide > HDMI).  
  **Workarounds:**  
  - Unarchive using the old ADS version.  
  - HDMI design guide will open in case it is already unarchived.  
- Simulating the "1_Sim_CA" design in the DDR4 CTB design guide prompts the netlist error.  
  **Workaround:** Open the schematic design "PatternGen_CA_Continuous" and arrange the pin numbers in order.  
- Simulating of schematics in the HDMI_Link_Simulation design guide prompt the netlist error.  
  **Workaround:** Open the schematic design "HDMI_Diff_RX" and arrange the pin numbers order in order.

Design Kits

- A design created using ADS2020 Non-Linear Demo Kit (NLD) and using NLD discontinuities like demo_bendP, demo_stepP, demo_teeP, etc. will not work as expected in ADS 2021.  
  **Workaround** – In ADS 2021, either update the design with the latest NLD i.e. NLD shipped along with ADS 2021; or continue to use the NLD that was shipped with ADS 2020.

Back to Feature Updates

Circuit Simulation

- **General**  
  - When the default value of a variable is blank, there is a simulation issue.  
  - **Workaround:** Set the default value of a variable to zero instead of blank.  
  - When using GoldenGate in ADS 2020 Update 2.0, some of the library files of RFIC cockpit options are not getting loaded due to license incompatibility. It is recommended to use ADS 2020 Update 1 when using GoldenGate in ADS.  
  - For details on license compatibility, see License Codeword Version Compatibility.  
  - Simulation Manager may not work on Windows and throw exceptions for some designs.  
  - ADS 2019 will not be compatible with Verilog-A files, which have been encrypted before ADS 2019. There is no change for non-encrypted Verilog-A files.  
  - TMI models are supported for pure Hspice syntax only. The support of hybrid syntax (mixing Hspice and Spectre) is planned for a future release.  
  - BSIMSOI models using TMI modeling is not supported yet. Classical BSIMSOI models are supported as before.  
  - TMI Aging simulations are not supported

- **ElectroThermal**  
  - In ADS, electro thermal simulation is assisted to automatically turn off the HBAHB and TAHB options for single tone HB. However, the electro thermal simulation for multi-tone HB needs a manual intervention to turn off the HBAHB and TAHB options for reporting voltage data.  
  - You may not be able to start a Transient/Envelope Electro-Thermal (ETH) simulation only when the same testbench is open in the viewer of Transient/Envelope thermal results. You need to close the viewer before launching a Transient/Envelope ETH simulation.
The electrothermal simulation will not run on designs created using Smart Mount for Multi-Technology feature.

Paths set while configuring the ETH controller and FloorPlanner Setup may need to be updated when the workspace is moved to a new location or updated the thermal directory in library configuration.

On a fresh Linux machine, electrothermal simulation fails with the following error message:

```
Heatwave returned an unknown error code 127.
```

**Workaround:** The error could be due to missing packages, for example, `libpng12`. Verify your system meets the requirements using the `linux_sys_check.sh` script. For more information, see Checking Installed RPM Files and the Operating System Version.

If you get licensing errors while running thermal simulation, you may need the following workaround.

**Workaround:** Rename the file `$HOME/.eesofrc`. For example, `$HOME/.eesofrc-orig`.

Electrothermal does not support remote simulation, batch simulation, Monte Carlo, tuning, Optimization, and Measurement Equations. Also, you cannot sweep directly on the DC controller.

All libraries referenced in a layout should use the same layout resolution, namely the OA database units (DBU) per user unit (UU).

You cannot run both a transient and envelope simulation on the same design from one testbench.

The calculation of power dissipation from passive components other than resistors may not be correct in harmonic balance simulations.

Electrothermal does not support the transient or envelope simulation that is controlled by a ParamSweep.

If you get "Maximum timestep reduced to half of shortest transmission line delay" warning, it can lead to transient simulation to not converge

**Workaround:** Unselect "Limit timestep for Transmission Line" option on Time Setup tab of Tran component to get it work.

On Linux, if you specify the THERMAL_DIRECTORY variable in eesof_lib.cfg file using backward slash (`\`), the thermal simulation does not run properly.

**Workaround:** Specify the THERMAL_DIRECTORY variable using forward slash (`/`) instead of backward slash.

The ETH viewer does not support 4K displays. A few instances of text and icons may appear distorted.

You receive an error message in substrate editor that you cannot use the same layer number more than once. You can safely ignore this error during thermal technology export.

On a fresh Windows 10 system, Electrothermal simulation terminates with an error.

**Workaround:** Install the following Microsoft Visual C++ runtime components:


**DDR Design**

- You receive an error message to check port numbering when performing simulation with SnP component for differential configuration.

**Workaround:** Select the first option in Pin Configuration for the SnP component.
HSD Design

- **SerDes**
  - You receive an error message and ADS is not invoked with LD_LIBRARY_PATH and MATLAB library path in RHEL 8. This happens due to library conflict between /lib64 and Matlab runtime.  
    **Workaround:** Add the Matlab library path using the following command:

    ```bash
    export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/lib64:$matlabroot/bin/
    glnxa64:$matlabroot/runtime/glnxa64:$matlabroot/sys/os/glnxa64:$matlabroot/
    sys/opengl/lib/glnxa64
    ```
  - You receive an error message when runtime libraries for some of the ADS example ibs files (for old AMI models) are unable to get installed automatically during the ADS install. The error appears even though the ibs file is supported on specific platform.  
    **Workaround:** Microsoft Visual C++ 2010 runtime library is required to run the dll files. Download the following library if it is not installed:

- **EM-SI/EM-PI**
  - **SIPro/PIPro, Via Designer**
    - On Windows 10 with Intel HD graphics, Via Designer may show an error message ‘Failed to use the connection between ADS and Via Designer.’ This has been isolated to the latest release of Intel HD Graphics drivers (23.xx.xx.xxx).  
      **Workaround:** Downgrading the graphics driver to the previously recommended driver resolves this issue (e.g., 22.20.16.4836, A05).
    - DirectX 9 as a graphics driver is no longer supported. DirectX 11 is thus be used by default. Run "diagdx" to verify which DirectX version is supported on your system.
  - **SIPro/PIPro**
    - ADS 2020 is not compatible with the latest available Samsung component models released in June 2018. The support for the component models is planned to be added in an upcoming update release.
    - Simulation failure when using components with S-parameter models or for which the model is defined using a lib/cel/view in case the Updating model does not require new simulation is not set. As a workaround, turn on the option. For PI-AC simulations, the options are turned on by default, for SIPro, this needs to be turned on explicitly.
    - If you run SIPro/PIPro on a fresh machine with Suse 11 or Redhat 6 installed, you may encounter the critical error "EMPro exited unexpectedly during execution." This is related to the graphics driver software.  
      **Workaround:** Upgrade to the latest vendor-specific drivers and OpenGL libraries for the graphics card.
    - **Alternative workaround:** Run the following commands:

      ```bash
      cd $HPEESOF_DIR/fem/2020.28/linux_x86_64/bin
      ./startempro --personality=sipi--driver=x11
      ```
Ignore any license-related error messages that may show up on executing these commands. The driver setting is saved per personality for future sessions.

- With split domains on, there are no results available until simulation results are available from the last simulation, or even after the simulation.
- Cadence® Allegro® (SPB 17.2 and SPB 17.4) is not supported on RHEL 8. As a result, the BRD Import and ADFI Export does not work on RHEL 8.
- In a vncserver session running on RHEL 8.4, you may encounter a critical error, “EMPro exited unexpectedly during execution.” This is related to the graphics driver software contained in the mesa-*\.x86_64.20.3.3-2.el8 packages.
  **Workaround:** Downgrade the packages to the previous version using the following command:

```
sudo yum downgrade mesa-*
```

The packages mesa-*\-20.1.4-1.el8.x86_64, and the dependent llvm package work.

- **PIPro-DC**
  - The power graph is not correct when VRM's or Sinks are defined, starting from pin definitions. All the other result data is correct. This issue does not occur when VRMs and sinks are defined from component instances.
- **PIPro-Electrothermal**
  - Current Density and Power Loss Density plots are not displayed properly on loading, however, switching to another Net or Layer fixes this issue.

**EM Simulation**

- **General**
  - Cadence Virtuoso IC version 6.1.7 is not supported on RHEL 8 platform.
  - In a vncserver session running on an RHEL8.4 platform, you may encounter the critical error “EMPro exited unexpectedly during execution.” This is related to the graphics driver software contained in the mesa-*\.x86_64.20.3.3-2.el8 packages.
  **Workaround:** Downgrade the packages to the previous version using the following command:

```
sudo yum downgrade mesa-*
```

The packages mesa-*\-20.1.4-1.el8.x86_64, and the dependent llvm package work.

- **RFPro**
  - The FEM and Momentum Generation 2 flows are state-of-the-art solvers but still evolving. In case it does not handle your design, switch back to Generation 1.
  - Combining 3D EMPro component(s) with bondwires or solderballs, all natively inserted in RFPro, will fail to reopen in RFPro.
  **Workaround:** Insert the 3D EMPro component in the layout view rather than natively in the rfpro view.
  - Multi-technology designs cannot be analyzed with Momentum.
  **Workaround:** Use the FEM simulator
Release Notes

- Project load fails with the error 'OccDesign::getNet: key not found' when a layout shape has a multi-bit net name (e.g. 'd<7:0>' or 'a,c,net1'). There is no workaround.
- With McAfee Endpoint Security (ENS) enabled, the Momentum surface current visualization hangs. **Workaround:** Disable the "Enable Adaptive Threat Protection" flag in McAfee ENS.

**RFPro and 3D Viewer**
- If the Geometry view is empty when opening the design, this may point to an issue with the graphics card driver.
  **Recommended workaround:** Upgrade to the latest vendor-specific drivers and OpenGL libraries for the graphics card.
  **Alternative workaround 1:** On Linux, launch the tool and force it to use the X11 driver. On Windows, set the driver to 'msw'. This preference is saved for the current user and per personality. You can do that by executing the following commands, e.g. in a shell on Linux:

  ```
  cd $HPEESOF_DIR/fem/2021.10/linux_x86_64/bin
  ./startempro --personality=rfpro --driver=x11
  ./startempro --personality=3dview --driver=x11
  ```

  Ignore any license related error messages that may show up on executing these commands. The driver setting is saved per personality for future sessions.

  **Alternative workaround 2:** Set following environment variable **EMPRO_SET_SOFTWARE_DRIVER_AS_DEFAULT=1.** This variable controls the default driver when no preference was set. On Linux, X11 is used. On Windows, MSW is used. You can clear all preferences as follows:

  ```
  cd $HPEESOF_DIR/fem/2021.10/linux_x86_64/bin
  ./startempro --personality=rfpro --clear-preferences
  ./startempro --personality=3dview --clear-preferences
  ```

- **EM Setup**
  - On a Virtual Windows 10 system with Microsoft Hyper-V Video display driver, the 3D EM Preview with EM Setup Preprocessing may bring up a dialog with a Hoops error, and, after suppressing the dialog, it opens up blank. There is no workaround.
  - FEM based parallel jobs on sitecluster with behavior configuration (qbehave) may show incomplete simulation logs.
    **Workaround:** You can view the complete log available in the following location: `<wrk_space>/simulation/ckpt/<cell>/layout/emSetup_FEM/proj.ep/Simulation/<simulation_num>/emds_dsn/design/emprfem*.log`

- **Distributed Simulations**
  - The example implementation of the sitecluster command for LSF clusters may lead to failing simulations if the path or number of threads is too large.
    **Workaround:** See the **workaround details** in the sitecluster documentation.

**Signal Processing Simulation**
- Ptolemy simulation with Matlab is not working on RHEL 8.
Import/Export

- Exporting with MentorDA link does not work with the latest Mentor Graphics software Version VX2.6.

Power Electronics

- PowerMOS_SiC power devices operate under a very wide range of voltage and current slew rates and it is a challenge to create a model that converges under all conditions – especially conditions that depend upon what components are connected externally to the power device in the circuit schematic. Please contact technical support if you encounter such an issue when attempting to use this model.
- If you run PEPro on a new machine with Suse 11 or Redhat 6 installed, you may encounter the critical error "EMPro exited unexpectedly during execution." This is related to the graphics driver software. **Workaround:** Upgrade to the latest vendor specific drivers and opengl libraries for the graphics card.
  - Or
  - Run the following commands:

    ```
    cd $HPEESOF_DIR/fem/2020.20/linux_x86_64/bin
    ./startempro --personality=sipi--driver=x11
    ```

    You can ignore any license related error messages. The driver setting is saved per personality for future sessions.

Installation

- While installing a new version of ADS, if you see “Previous version detected” error even after you have already run the uninstaller for that version of ADS, you may need to manually uninstall ADS before installation of the new ADS. To manually uninstall ADS, perform the following steps.
  a. Exit the current ADS installation session if it is running
  b. Remove or rename the file `.com.zerog.registry.xml` under the folder `C:\Program Files\Zero G Registry`. Both the folder and the file are by default hidden, so you may need to change the folder viewing setting to show hidden files and folders, do so via the Advanced settings of the View tab in the Windows Folder Options dialog box.
  c. Remove the ADS installation directory through the Windows Explorer.
- After performing the above steps, you can re-start the ADS installer.
Licensing

- You may observe additional License Usage when Client Machine reconnects to network after intermittent disruption.
  **Workaround:** In case of network interruption on the client machine, to reclaim the inactive licenses, a TIMEOUT can be set using the TIMEOUTALL feature in options file (minimum time period of 15 minutes). The inactive license may stay checked out for this period of time.

- Unable to install Licensing Hardware Key Drivers on Windows.
  **Workarounds:**
  - Turn off UEFI Secure Boot (BIOS) and use the default 6.3 version of the Wibu key driver delivered with the EEsolf Licensing tools.
  - Turn on UEFI Secure Boot (BIOS), upgrade to ADS 2020 Update 2.0 and use the 6.51 WibuKey driver version available in the 2020.02 License tools installation directory.

  **NOTE:** You will not be able to run older ADS releases with the 6.51 WibuKey dongle drivers.

- You may observe issue in recognizing more than one FLEXID on Linux platform with the 2020.02 license tools.
  **Workaround:** Consolidate your licenses to one FLEXID and configure the same.

- Setting FLEXLM_DIAGNOSTICS to the highest level (FLEXLM_DIAGNOSTICS=3) on Windows client may cause a crash during license checkout. Flexera is investigating this issue.
  **Workaround:** It is recommended not to use the FLEXLM_DIAGNOSTICS on Windows clients or use it at lower level (FLEXLM_DIAGNOSTICS=1 or FLEXLM_DIAGNOSTICS=2).

- WibuKey 6.5 software driver is not supported on SuSe 11.
  **Workaround:** Use the older WibuKey 6.30 software driver (WkRt-Lin-6.32.1504-500.x86_64.rpm).

- Licensing may not support a license file path that is too long. This will likely occur when you have too many license files.
  **Workaround:** Remove some license files, move the license files to a shorter directory path or to combine license files into a single file.

- License Setup wizard may not be able to start license server with many license files. During setup, it may lead to a situation where a command prompt window appears/disappears incessantly. This is due to the fact that License Setup wizard is not able to start lmgrd with a long command line and may get stuck in a loop.
  **Workaround:** It is recommended to combine all license code words tied to same MAC ID into single license file to avoid setting large number of license files.
  - Try to use a shorter path to place license files.
  - If \#1 and/or \#2 does not help, start the license server (lmgrd.exe) from the command line (e.g. lmgrd.exe -c <lic-file-path> -l <license_server_log.txt>) and then set <PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@localhost for product you want to use on same PC.

- Dongle drivers for Flex-10 dongles on Linux are release specific. Installing the latest dongle drivers on Linux will function properly only for the most recent EEsolf releases.
  **Workaround:** Install and use dongle drivers as needed. If you need to run the most recent EEsolf releases, use the latest Flex-10 dongle driver. If you need to use older releases, uninstall the latest dongle driver and re-install the older dongle driver.

- FLO and EEsolf License setup are writing server logs at different locations. However, the EEsolf server log file location is updated in the License Manager > Environment tab.
- When multiple same-named INCREMENT lines of different version exist on the license server, few advanced FlexNet options to reserve/limit licenses may not work properly.
- Product Selector “Check Availability” generates incorrect results (which leads to license failure) for older releases when multiple date base versions of like-named bundles exist in the license pool.
- In Linux, Product Selector **OK** and **Cancel** Buttons locations are reserved.
- Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best practice of the least-privilege security therein results in the License Server related Windows Service to run with the LocalService Account privilege (instead of the LocalSystem privilege as before.) Running with the LocalService Account privilege, an executable can no longer access any files located in the per-user specific type of folders. As a result, any license file placed in those folders can no longer be accessed by the License Server when the License Server is automatically started via the Windows Service upon each PC reboot. For the local node-locked license, this would not result in any disruption to the usage of EEsof applications; however, for the license installed on a network PC that is accessed by multiple client PCs, this may cause EEsof applications not to start after the network PC reboots.
  **Workaround:** Store your license files in the Windows folders that are accessible by the LocalService Account privilege. For example, C:\ProgramData or C:\users\public are both qualified choices. In general, any folder that has the “Users” group listed in its Properties > Security page and this "Users" group has the read permission enabled should work.
- Using the default port to connect to a license server may cause a delay when checking out licenses. If no port is given in the license file, Flexera scans ports 27000 to 27009 to find the port. Starting from FlexNet Publisher 2015 (aka version 11.13.1), the default timeout for the response from each port increased from .1 seconds to 3 seconds.
  To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof License Setup Wizard (from Licensing 2017.01 onwards) handles some common situations such as: where it detects license file(s) without port, when users get a new license file with port 27009, or when all license files for a vendor daemon does not have same port.
  **Workaround:** If the user cannot change the port, or wants to use the default Flexera ports, the environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the performance degradation. However, if the network latency is an issue in your environment, you may need to fine-tune this setting to minimize the general performance degradation while still accommodating the network latency.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing bits may need to manually edit license files to comply with the following rules:
- All license files for a vendor daemon on a server must use the same port (or all be blank).
- Using the default port (blank) is allowed but may result in longer checkout times.
- If setting up a network server, select an unused port that is not blocked by a firewall.
  **Workaround:** If the network cannot change the port, or wants to use the default Flexera ports, the environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the performance degradation. However, if the network latency is an issue in your environment, you may need to fine-tune this setting to minimize the general performance degradation while still accommodating the network latency.

- Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may hang at 4% (percentage vary based on the products) for few hours or even more on some specific machines.
  **Workarounds:**
  - Disable Firewall setting in Anti-Virus Software installed on the PC.
  - Download and unzip process explorer from the below link and then invoke procexp.exe.
    Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it will continue the product installation.
After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) successfully and try to invoke the software or License wizard, you may encounter “api-ms-win-crt-runtime-l1-1-0.dll” missing error.

**Workaround**: Install the Update for Universal C Runtime in Windows. On Windows 64-bit system systems, the file to install is x64 version of the Microsoft hotfix KB2999226. A copy of the Windows6.1-KB2999226-x64.msu Microsoft 64-bit hotfix installer can be found under the C:\Program Files\Keysight\EESof_License_Tools\bin directory. The Microsoft hotfix KB2999226 can be found under the Update for Universal C Runtime in Windows page at https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows as well.

On a newly formatted RHEL system, the EESof Licensing tools may fail to boot. This is because the FlexNet Publisher 2015 requires a certain rpm

**Workaround**: Under the EESof product installation directory, there exists a utility script named “Linux_sys_check.sh” under the bin directory. Run this script to find out whether any rpm is missing; run this script with a “-y” command-line option to also have all the missing rpms automatically installed if you have the sudo or root privilege.

License server may stop recognizing Flex-10 dongle on some systems within a few hours after starting

**Workaround**: If v6.10 or v6.11 is found and experience this problem then upgrade the WibuKey drivers to v6.30/6.30b from Wibu Systems.

Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine

**Workaround**: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.

There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating codewords in one license file can result in: a) Remote simulations not working or b) A second local simulation not working in case the license is node-locked and also has incorrect version.

**Workaround**: It is strongly recommended that you do not mix node-locked codewords and floating codewords in one license file nor in any configuration that ends up with node-locked codewords and floating codewords both available on the same server. In other words, put the node-locked license and the floating license on different servers, and point to the respective one based on what you need to run.

If a user simultaneously runs two instances of a product and has mixed different versions of the same codeword on one license server, extra licenses may be pulled and result in unexpected “Licensed number of users already reached for this feature” errors.

**Workaround**: We recommend you remove expired codewords, to separate out the new and the old versions of codewords into different files and different servers, and to point to the respective one based on what you need to run.

Not specifying the TCP/IP port for the license server during license setup may lead to unexpected behavior and/or license checkout failure on the Windows platform. We strongly recommend you to always explicitly specify the TCP/IP port associated with each license server.

A node-locked and floating bundle operating on Linux cannot be shared between products using EDA License Tools version older than 2014.01 when run at the same time.

License Setup Wizard does not remove any previous user-configured FLEX Windows License Service manually set up by a user using FlexNet’s lmtools.

**Workaround**: You must remove the previous user-configured Windows License Service via Lmtools.

- Run the Lmtools.exe from C:\Program Files\Agilent\EESof_License_Tools\bin to invoke the Lmtools utility. The Lmtools utility window is displayed.

**CAUTION** If you have installed an EEsol product released before 1st August, 2014 on your system prior to installing an EEsol product released after 1st August, 2014 then the default EEsol Licensing tools path will remain C:\Program Files\Agilent\EESof_License_Tools. On the systems that only have EEsol products released after 1st August, 2014 installed then the default EEsol Licensing tools path will be C:\Program Files\Keysight\EESof_License_Tools.
In the Service/License File tab, check the Configuration using Services option. All user-configured FLEX Windows License Services will be listed.

- Select the service you wish to remove.
- Select the Config Services tab and click the Remove Service button to remove the service.

To ensure that the license service or Imgrd is running, click View Log. A log window appears that confirms whether agileesofd and Imgrd are up and running.

- While running multiple versions of prior ADS releases together, set ADS_MAXIMUM_BUNDLE_USAGE=ON in your environment so that all of them will use the same method to check out licenses. Otherwise, you might receive an error message, "Licensed number of users already reached".

- On some Windows 7 machines, when more than one definition of an Ethernet adapter exists (duplicates), license checkouts may appear to hang up.

Workaround: Disable the duplicate network card definitions in your network settings: Control Panel > Network and Internet > Network Connections. This issue has been acknowledged by Flexera and they have created a bug report (SIOC-000103097).

- For LSF style distributed simulations, ensure that the PATH on the client computer points to the $HPEESOF_DIR/EEsof_License_Tools/$(architecture) directory that corresponds to the EEsof release being used. This needs to be done in order to ensure that the proper version of the Flexera utilities (like lmutil) gets picked up in the path before any older in-compatible versions (that may also be installed on a users’ system.)

- License Setup Wizard (aglmwizard.exe), which is used to set up and record the license path would not work if you already have an environment variable set for ADS_LICENSE_FILE.

Workaround: You can use ADS_LICENSE_FILE variable to point to license file or refer to Licensing (For Administrators).

- The License Setup Wizard will exit or not properly configure a license server, if the server has all of its licenses currently in use.

Workaround: Wait for a license on the server to become available as you normally would before launching the product.

- Unable to set license in case unicode characters are used either in path or license file name because the Flex License Service does not support these characters.

- The Product Selector tool will be unable to display the license server status properly when connected to older license server.

Workaround: Upgrade your license server to the latest version.

- EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the default firewall settings.

Workaround: Prior to installing EEsof Licensing Tools, temporarily turn off the McAfee LiveSafe firewall.

- Licensing setup steps on systems with McAfee LiveSafe installed can fail.

Workaround: Under the McAfee LiveSafe firewall settings, under Port and Settings, allow the use of port 27001 for lmgrd.exe under the EEsof Licensing Tools installation bin directory. Under Internet Connections for Programs, enable lmgrd.exe, aglmmgr.exe and aglmwizard.exe for all devices and turn off monitoring.

- On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an newer EEsof product is installed prior to installing the older product. For example, if a users installs Advanced Design System 2017 and then installs Advanced Design systems 2014.01, the user can have boot time errors with ADS 2014.01.

Workaround: For Advanced Design System users, set a system environmental variable named ADS_LICENSE_FILE under the Control Panel/ System, and Security / System / Advanced system settings and under the “environmental variables”. Add an System variable named ADS_LICENSE_FILE and the value will be the path to your local license file or the port@host setting for your site.
Release Notes

Third Party Applications

- Spyder application menu bar becomes inactive when the window is maximized using View > Full Screen or by pressing F11 (shortcut key to maximize the screen).
  Workaround: Press F11 again to make it the default screen. The menu bar is now active and works fine.

Verification

- Cadence applications (Assura) is not supported in RHEL 8 Linux Distribution.

Virtual Test Bench

- From VTB 2021, SystemVue VTB's QT help file is integrated into SystemVue 2021 VTB installer. However, help does not open, when you press F1 for a VTB component.
  Workaround: Perform the following steps:
  a. Open a command window.
  b. Set the path to ADS help directory. Execute the following command:
     On Windows
     ```
     set path="<ADS_Install_DIR>\bin\Help";%PATH%
     ```
     On Linux
     ```
     export PATH=<ADS_Install_DIR>/bin/Help:$PATH
     ```
     On RHEL 7 (due to library related issue)
     ```
     export HPEESOF_DIR=<ADS_Install_DIR>
     export LD_LIBRARY_PATH=$HPEESOF_DIR/lib/linux_x86_64:$HPEESOF_DIR/lib/linux_x86:$LD_LIBRARY_PATH
     export PATH=$HPEESOF_DIR/bin:$PATH
     export PATH=$HPEESOF_DIR/bin/HELP:$PATH
     ```
Where,
<ADS_Install_DIR> is the ADS installation directory.
On Windows: The default ADS location is “C:\Program Files\Keysight\ADS<version>”
On Linux: The default ADS location is “/usr/local/ADS<version>”.
For example, <version> is 2022

c. Invoke VTB help. Execute the following command:
On Windows

```shell
assistant -collectionfile "<VTB_Install_DIR>\Help\vtb.qhc"
```

On Linux

```shell
export SYSTEMVUE_INSTALLATION_DIRS=xxx/SystemVueVTB/2021

assistant -collectionfile $SYSTEMVUE_INSTALLATION_DIRS/Help/vtb.qhc
```

Where,
<VTB_Install_DIR> is the SystemVueVTB installation directory on Windows.
xxx is the directory where unzip or untar of VTB package is done on Linux
On Windows: The default VTB location is “C:\Program Files\Keysight\SystemVueVTB2021”
You can also refer to the online version of the SystemVueVTB documentation.

- For SystemVueVTB 2020 Update 1, help does not open, when you press F1 for a VTB component.
- For details, refer VTB documentation.
- When using VTB on Virtual Machine (VM), if SystemVue crashes then ensure to restart your system.
- To use VTB, ensure ADS is installed in a path that has only ASCII characters.
- VTB is not supported on the SuSe 11 platform.
- Backward compatibility
  In ADS, the customized VTB can have a backward compatibility issue.
  **Workaround:** To fix this issue, use one of the following methods:
  a. **Open** and **Save** the custom VTB in SystemVue2020Update1. Now, you can use the custom VTB in ADS.
  b. A built-in workspace conversion tool is provided in the installer. You can convert the custom workspace (.wsv) to the newer SystemVue version. Use the following steps to convert the workspaces:
     - Open Command Prompt in the **Administrator** mode.
     - Browse the location of the old workspace. For example, C:\ADS_VTB.
     - Run the following command parameter.
C:\ADS_VTB\<SystemVueVTB_Installation_Dir>\bin\WorkspaceConversionToOldManaged.exe" VTB_Examples.wsv VTB_examples_new.wsv

Where,
1. <SystemVueVTB_Installation_Dir> is the location where SystemVue VTB package is installed. For example, C:\Program Files\Keysight\SystemVueVTB2020Update1.
2. VTB_Examples.wsv is old SystemVue file and VTB_examples_new.wsv is converted file.
3. The following successful message is displayed.
   Created: VTB_example_new.wsv
4. You can now use the VTB_examples_new.wsv workspace in ADS.

- When multiple VTB versions are installed, the VTB package in the Library Configuration Editor remain fixed to a particular VTB version. However, symbol view uses the correct VTB version.
- While migrating the same VTB component from one VTB package to another (example: SystemVueVTB2020U1 to SystemVueVTB2021 or vice versa) using Swap Components option in ADS, the enumerated parameters are not getting updated automatically to the default value.

  **Workaround:** It is recommended that while swapping the component from one VTB version to another VTB version, ensure to manually:
  - select the desired enumerated parameters before using the component
  - or
  - select a new VTB component from the component palette using the required VTB package.

---

**Examples**

- Examples under <ADS Install Directory>\examples \Instrument_links folder are not getting opened on Linux where as they are opening fine on Windows.
  - **Workaround:** Rename the 'Instrument_links' folder to 'Instrument_Links', if you have write permission to the <ADS Install Location>\examples folder. In case you do not have the write permission then proceed with manual unarchive process (File > Unarchive from the ADS Main window) pointing to the Example workspace.

- Example search might not work and prompt you the "Database is locked" error when ADS installation is on NAS.
  - **Workaround:** Restart the nfslock service on client. In case the problem still persists, reboot the client to unlock the database.

- Unable to compile Pin Diode Model using Visual Studio 2012 on Windows 7 64-bit platform.
  - **Workaround:** Delete the contents of the directory examples\RF_Microwave\UserCompiledModel_wrk\UserCompiledModel\lib.win32_64 before using UCMs.
- An error occurs while running a custom VTB.
  - **Workaround:** Download and run a custom VTB from the following location: <ADS Install Location>\SystemVue\2016.08\win32_64\VTB.
On Windows, Printing directly from installed help generates non-readable output.  
**Workaround:** Use the PDF version of the document for printing purposes.

- From 2017 onwards, in the installed help when you open a page using the "Open a link in new tab" option the help does not open a page in a different tab by default. You need to set the preferences to open any link in a new tab.
  
  To set the preferences:
  
  a. From the 201x version of the installed help, Click **Edit > Preferences**.
     The Preferences Dialog box is displayed.
  b. Select the **Options** tab.
  c. Under Appearance, select the **Show tabs for each individual page** option.
     This is a one-time setting for a particular release of a product.

- Unable to open online help, any external link, or Embedded Survey link in Linux on Mozilla Firefox browser.  
  **Workaround:** Use Mozilla Firefox version 39 or above or keep the Mozilla Firefox window open and then try to open online help.

- While using the installed help, you may encounter issues like help not showing any content, it throws an error, it displays unexpected hierarchy in the Content tab, or it does not display any search results.  
  **Workaround:** Close the help, delete the contents of the following directory, and open the help again.
  
  - On Windows:  
    C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help
  
  - On Linux:
    - $HOME/.local/share/Keysight/Help
    - $HOME/.cache/Keysight
    - $HOME/.cache/rfdeqthelp

- The installed help search does not support [] or {} or any other text using these combinations.

- On Linux, Konqueror web-browser does not display the online help properly. It may not display help pages at all or may display them broken and with errors.  
  **Workaround:** Use Mozilla Firefox to view the online help.